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Preface

Welcome to SNAP
Welcome
Back in 2007, the one thing missing from my suite of telecoms programs was an
NNTP news reader. Until then, I had considered that the sheer number of groups
on Usenet, and the number of messages in some of the groups, was going to be
obstacle to actually accessing the groups on a IIgs.
After some thought, and initially to help support the A2Central news groups, I
realised that it would be possible, even though things might be rather slower
than using a Macintosh or PC.
Update release v1.2.2
This is an update release of the original SNAP, which fixes a multitude of bugs, as
well as introducing many enhanced features. Refer to the Change.List file in the
Archive folder for details of any updates, and please read this manual fully to see
what has changed, and what has been been enhanced from the original SNAP.
SNAP now supports the Undo Manager, and a copy is included with the archive.
Just drop Tool 132 into the Tools folder in the System Folder and reboot.
If Check File 1.0.1 or later is installed, SNAP now checks for updates at startup.
You can Ignore this in Settings if you wish.
Introduction
SNAP is an online NNTP news reader client, which can access Usenet and other
compliant news servers. SNAP gives you access to multiple news servers, using
custom news group lists, reads group messages, and lets you optionally reply to
them, both direct to the news group, or optionally to an email address.
It is especially suitable for accessing the comp.sys.apple2 newsgroups, which
currently are the home of the Apple II community.
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What is SNAP
SNAP is an online NNTP news client, which can access not only commercial, but
also your ISP's Usenet news servers.
Usenet is so vast, that it is quite unrealistic for a news client on the IIgs to be able
to fully handle the binary groups, where many hundreds of Gigabytes are posted
daily, or to handle offline, the more than 100,000 separate news groups that might
be available from commercial news servers.
To be able to work sensibly with this enormous amount of data, SNAP works as
an online news client, and only manually saves messages to disk as required. The
drawback to this approach is that messages, and message headers, have to read
their data on the fly directly from the news server. As a result, you will find that
SNAP works best with an 'always on' connection, such as that provide by an
Ethernet card connected to a broadband link. The advantage of the online
approach is that you can access any group, or read any message. For practical
reasons, messages larger than 256K will be truncated when displayed.
Given those limitations, you will find that SNAP works well with commercial
news servers. SNAP has been tested extensively with Giganews and Astraweb, two
of the largest and most popular of the Usenet news severs. To report bugs, or
suggest new features, email:

<spectrumdaddy@speccie.uk>

SNAP is Freeware and Copyright © 2007-2020 Ewen Wannop
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Setup

SNAP NNTP News Reader
Requirements
You will need at least 1Mb of free memory, and have Internet access through
Marinetti 3.0b7 or later. SNAP can use dialup modem access through Marinetti,
but ideally an Ethernet connection directly to a broadband link, will give you a
faster experience.
For best results you should also have a hard disk for storage, or other pseudo
disk, such as a CF card. You will only need about 5Mb of free disk space to store
configuration files, even for the more than 100,000 groups that news servers such
as Giganews holds!
Most directly accessed news servers, such as those provided by your ISP, do not
need a username or password, but to access other news servers, you may need to
first create an account with them.
If you wish to send mail from SNAP, you will also need to have a suitable SMTP
mail account.
To obtain SNAP, NiftySpell, Babelfish™, the HTML Tool, the Uthernet Link
Layer, or any of my other software::
http://speccie.uk
To obtain the latest version of the Marinetti TCP/IP stack:
!http://www.apple2.org/marinetti/
To find out about, and order an Uthernet card:
http://www.a2retrosystems.com/
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Installation
In addition to Marinetti, SNAP requires some custom System Tools, and some
Fonts to be installed. You may already have these installed, but if not, they are
supplied in the SNAP archive. Do not overwrite any newer versions of these files.
In most cases, just drop the files onto the System folder, and they should
automatically be put into the correct folder. Reboot your IIgs afterwards.

SAM2.Archive folder contents:
HTML Tool folder:
Put Tool130 into the System/Tools folder.
Put the contents of the Fonts folder into */System/Fonts
TimeZone folder:
Put the TimeZone CDEV into the *System/CDevs folder.
Put Tool056 into the */System/Tools folder.
Hierarchic folder:
Put the Hierarchic CDEV into the *System/CDevs folder.
Fonts folder:
Copy the three Font files into the System/Fonts folder.
Help folder:
Put the Help NDA, and the Help.Files folder into the */System/Desk.Accs
folder. If there is already a Help.Files folder in Desk.Accs, just copy the
contained SNAP folder. across into it.
SNAP folder:
Create a folder on the disk where you wish to run SNAP from, and copy the
SNAP application to it. This can be anywhere you like on your system.
UndoManager folder:
Drop Tool132 into the Tools folder in your System folder, and reboot.
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Marinetti
Install and configure Marinetti to suit your Internet connection. If you need
the Sweet16, or Uthernet Link Layers, the latest versions can be downloaded
from my web site:
http://speccie.uk
NiftySpell
If NiftySpell has been installed, SNAP will support spell checking directly from
the Mail, Posting, and Editor windows. You need to first install NiftySpell v1.1,
which can be downloaded from my web site:
http://speccie.uk

Babelfish™
If Babelfish™ has been installed, SNAP will support import and exporting files
through Babelfish™ from the Editor window. You need to first install
Babelfish™, which can be downloaded from my web site:
http://speccie.uk

Running SNAP
Double click SNAP to run the program. Alternatively, you can create an alias of
SNAP, and put it on your desktop for easier access.
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Configuration
Run the 'SNAP' application, and select 'Edit Servers' from the 'File' menu. Click
'New' server, give it a name for the menu title, and enter the URL of your news
server. If this server requires a username and password, enter those in the next
two boxes.
Now enter either your real name, or a nickname, in the 'Real Name' box, and a
suitable email address for any replies in the 'Reply To' box. This address must at
least look like a valid email address, but if you do not expect any email replies, or
wish to protect yourself from spam, it can be any pseudo email address of your
choosing.
The mail server boxes may be left empty at this time, and for servers such as
Giganews, leave the 'XPAT' box unchecked.
If you want to add signatures at this time, click the 'Signatures' button, and edit
the fields as necessary.
Click 'OK' to save the settings. At this point, SNAP will attempt to go online to
verify the addresses. If anything is not to its liking, SNAP will return you to the
edit dialog to correct the mistakes.
If all is well, when the Edit window has closed, click 'Cancel' from the Servers
list dialog, and then from the 'File' menu, select the server you have created from
the 'News Server' popup menu. Once a server has been selected, it will show a
tick mark against its name.
From the new named menu that will appear, select 'Build Group Lists', and click
New. Give it a suitable name that will appear in the menus, and click OK. An
empty window will open. Click 'Add Entry', and enter the name of a Usenet
newsgroup, such as comp.sys.apple2. When you have entered all the groups you
wish to read, close the window.
You are now ready to go online and read and reply to messages on a group such
as the CSA2 forums.
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Reading messages
From the named menu, select one of the group lists you have created, from the
'Open Group List' popup menu.
SNAP will go online and read the message counts for that group list. This may
take a few moments, depending on the speed of your connection.
Double click the forum you wish to read messages from, and wait while it builds
a list of the message headers. If there are a large amount of unread headers, click
the 'More' button to see the next batch.
Once the headers are displayed, you can double click an entry to read the
message itself.
While viewing a message, you can press OA-> to display the next message in the
sequence.
When done, either press OA-Q to Quit, or close the windows one by one by
pressing OA-W. If the option is set, the number of the last message you have read
will be used to update the message counters, so the next time you open the group
lists, only messages from that number onwards will be displayed.
Replying to messages
While reading a message, you can choose to send a 'New Mail Message', 'Reply By
Mail', 'Forward' the message to a mailbox, add a 'New Posting', or 'Follow Up' the
message you are reading. Select these items from the 'Messages' menu.
Finally
This Manual contains the detailed instructions on how to use SNAP, along with
full details of its many features.
For any help that is not covered in the documentation, please contact me at:
<spectrumdaddy@speccie.uk>
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Menus

SNAP Quick Reference
!

!

The Menus

Apple Menu
!

About SNAP
Opens a small window to show the current version of SNAP. Click on the window
to close it.

File Menu
!

News Server ▶
If you have defined one or more news servers, select one to be the current active
server from the popup sub-menu. Once selected, a tick mark will show the active
server, the {Server} Menu will be renamed, and any related group lists will be
loaded for use.

!

Edit Servers
Opens a dialog where you can define news servers, or edit the settings for a news
server entry. Refer to 'Editing Servers' for more details.

!

Open
Opens an item from a groups or headers list.

!

Close
Closes the current window.
Save & Save As
Either automatically saves the text from the current window (Save), or ask which
folder you would like the text to be saved to (Save As). Refer to 'Saving Text' for
more details.
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!

Insert Text File
Inserts a text file into the current window. Refer to 'Inserting Text' for further
details
Babelfish™ ▶
Imports or Exports text through the Babelfish™ translators. Only active if
Babelfish™ is installed. Refer to 'Babelfish™' for further details.

!

Preferences
Opens a small window where global settings can be edited. Refer to 'Setting
Preferences' for more details.

!

Page Setup
Opens the standard Page Setup print dialog.

!

Print
Sends the entire body text, or a selection, from the current window to your
selected printer. Refer to 'Printing' for more details.

!

Quit
Quits SNAP, returning you to the Finder, and closing all open group windows.

Edit Menu
!

Undo
Undo the last 32 changes to the text (Refer to the Undo PDF Manual).
Redo
Redo the last 32 changes to the text (Refer to the Undo PDF Manual).

!

Cut
Cuts the selected text, and places it on the Clipboard.

!

Copy
Copies any selected text to the Clipboard.

!

Paste
Pastes any text on the Clipboard at the cursor point, replacing any selected text.

!

Clear
Deletes either selected text, or text to the left of the cursor.

!

Select All
When editing text boxes, or body text, this will select the entire text.
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!

Find & Find/Replace
If you are viewing, or working with text in a message window, this menu item will
open either a 'Find', or a 'Find/Replace' dialog. Refer to the appropriate section,
or the 'Editor', for further details.

!

Search
Searches a selected group for messages that match a target string in either the
Subject or From fields. Refer to 'Editor' for further details.

!

Editor
Opens a general text editor that you can use to prepare or work with messages.
Refer to 'Editor' for further details.

!

Spell Check
If NiftySpell™ is installed, will spell check the text in the current window.

!

Choose Font
Lets you change the font of the Editor text.

!

Show Log
Opens the current SNAP.Log file. Refer to 'Log File' for more details.

!

Show Clipboard
Displays the current contents of the Clipboard.

Message Menu
!

New Mail message
Compose and send an email message. Refer to 'Sending Mail' for more details.

!

Reply By Mail
Send a reply to a news group message as an email. Refer to 'Sending Mail' for
more details.

!

Forward
Forwards a news group message as an email. Refer to 'Sending Mail' for more
details.

!
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!

New Posting
Posts a new message to a news group. This will start a new thread in the group.
Refer to 'Posting News' for further details.

!

Follow Up
Replies to a message in a news group. The message will be posted to the current
thread. Refer to 'Posting News' for further details.

!

Previous Message
While viewing a message, will take you to the previous message in the headers
list. Refer to 'Reading Messages' for further details.

!

Next Message
While viewing a message, will take you to the next message in the headers list.
Refer to 'Reading Messages' for further details.
Item Info
From a group list, opens a window which shows group info, and lets you set the
last message read number. From a header list, opens a window to show the
message number.

!

Mark Read
Will mark all the messages in a selected group as read. Refer to 'Reading
Messages' for further details.

!

Mark Pending
Will mark all the messages in a selected group as unread or pending.

!
!

Archives ▶
!
Sent Mail
Shows a list of all the emails that you have sent that are in the /Archived/
Sent.Mail folder. Refer to 'Archives' for further details.
Group Posts
Shows a list of all the posts that you have sent that are in the /Archived/
Sent.Messages folder. Refer to 'Archives' for further details.
Saved Messages
Shows a list of all the posts that you have saved that are in the /Archived/
Saved folder. Refer to 'Archives' for further details.
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{Server} Menu
{Server} will be replaced in with the name of the currently active server.
!

Open Group List ▶
If you have created one or more group lists for the current server, the popup will
show the list names. Select an item to get the message counts for that list. Refer
to 'Reading Messages' for further details.

!

Build Group Lists
Opens a dialog where you can create and delete group lists. Only lists linked to
the current server will be shown. Refer to 'Managing Lists' for further details.

!

Edit Group List ▶
Opens a window where you can edit the groups, and set local preferences for
group lists. Select the target list from the popup sub menu. Refer to 'Managing
Lists' for further details.

!

Show Full Newsgroup List
Displays the entire list of news groups for the current selected server. Refer to
'Full Newsgroup List' for further details.

!

Rebuild Full Newsgroup List
Rebuilds or sorts the entire list of news groups for the current selected server.
Refer to 'Full Newsgroup List' for further details.

Keyboard Shortcuts
Note: Menu items are dimmed or enabled depending on the currently open
window.
Note: Some menu items have OA-key equivalents. Wherever there is an
equivalent, you can use this instead of selecting the menu item itself.
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Basics

Working with SNAP
Usenet and News Servers
Usenet is a global collection of news servers, holding many billions of news
articles, held in a number of message groups. As articles are posted to a group on
any one server, they are then propagated to any other key servers that hold that
same news group. In this way, as the messages migrate round the world, Usenet
becomes the equivalent of a giant global Bulletin Board.
News servers conform to the NNTP protocol, and optionally require user name
and password access. Most ISPs have access to news servers, and access
information will have been given to you when you set up your ISP account. Often
news servers hosted by your ISP do not require a username and password for
access, but other news servers may be by subscription only, and will require you
to authenticate your access. For instance, the Giganews or Astraweb servers,
require you to have an account, and then enter a username and password, if you
want to post messages to the news groups.
Any server that conforms to the NNTP protocol, can be accessed with SNAP.
There might be well over 100,000 groups on a well stocked news server, or there
may only be a handful. It is up to the news server host to decide which groups it
will hold. Some news servers hosted by some IPSs, may not hold the binary
groups, and some ISPs may choose to censor some of the more controversial
groups. In addition, a particular server may choose not to migrate news outwards
from its local groups, so messages posted, will become local to that server only.
For instance, the news server with my ISP, holds a small set of local groups
specific to the ISP, and messages in those groups are not propagated beyond its
own news server.
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All Usenet messages, whether binary or text, are constructed and posted in
exactly the same way. The only difference is that the 'Binary' groups will usually
hold multiple messages relating to a single subject, which allows large binary files
to be posted spread over a number of smaller messages. To reconstruct the
original file, which might consist of many hundreds of message parts, will need a
specialist news reader that can decode and amalgamate the messages into one
output file. This is beyond the scope of the IIgs, with its limited speed and
memory, and especially beyond a news client like SNAP.
The bulk of the news groups will only hold text messages, and these are well
within the scope of SNAP. Bear in mind, there can still be many hundreds or
thousands of messages in a selected group. You will just need to be patient, while
SNAP, and the IIgs, does its work!

The SNAP Program
SNAP supports access to multiple news servers, and multiple group lists. You
work with a single news server at a time, switching between any other servers you
have defined from a popup menu. For each news server, you can build multiple
group lists, each holding up to 32 entries. There are also some custom settings
that you can apply to each group list, and some global settings that you can apply
when working with all the servers and the group lists.
Read the 'Quick.Start' file for more information on getting going with SNAP.
Once you have built a Server entry, and its associated Group Lists, you select the
Server from the File Menu, and the List you wish to use from the {Server}Menu
'Open Group List' popup. SNAP will go online, and read the message counts for
the groups in that list. You can select Item Info from the menu to reset the last
message read number, and the Article Limit.
With the message counts displayed, select a group entry in the list, and either
double-click the entry, or click the 'Show Messages' button. SNAP will go online,
and retrieve and display the message headers for that group. Only the message
headers are retrieved at this point, which allows their details to be extracted to
build the entries in the message headers list. The number of headers that are
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retrieved at any one time, is defined when you edit a group list. You can select
Item Info from the menu to show the actual message number for an entry.
If you click the 'Update' button while the group counts are displayed, SNAP will
check for any new messages, and also check if there have been any new news
groups added to the full group list. If there are new groups, these will be added
to the end of the full group list.
From the display of message headers, choose one of interest, and double click to
read the actual message itself. While the message is displayed, you can choose
from available menu items, to either go to the next, or previous message, and to
respond to the message in various ways. Refer to 'Posting News' and 'Sending
Mail' for more details.
Close the message display window to return to the message header list, where
you can select further messages to read. If it is active, you can click the 'More'
button, to read further message headers.
If you have checked the 'Mark Last Read' box for the current group list, the
number of the highest message you have read will be used to prime the counters
the next time you open that group list. While a group list is displayed, you can
choose to reset this counter, and mark all messages within the group as either
'Read' or 'Pending'.
When you close a message header list, you are returned to the group list. If you
have posted a message, the message counters will be updated, otherwise if you
wish to update the message counts, click the 'Update' button. The counts for all
the groups will then be updated.
To switch to another group list, or to another server, you must first close the
windows for the current group. In many windows the 'Quit' item is also
available. This will Quit SNAP, closing all open windows as it goes.
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Reading Strategy
Some message groups may only contain a few messages, and others may contain
millions. As SNAP is an online reader, it does not keep any messages for you to
later read again. In order to read a message again, you will need to actually go
through the group list to find it once more, or use the 'Search' feature to find it.
Alternatively, you can ‘Save’ or ‘Save As’ the message for later reading, or Print it
to your printer.
There are two strategies you can use when reading group lists. Reading
backwards from the new messages first, or reading forwards from the last read
message. See ‘Setting Preferences’ for more details on how to change this setting.

Reading new messages first
With the ‘List new messages first’ option checked, messages will be listed from
the newest message in the group, listing backwards to the last unread message.
This method has the advantage that if you are looking at a new group, or one that
has many new messages each day, you do not have to go through hundreds of
messages to see the newest ones.
If you have the ‘Mark Last Read’ flag checked, then when you close the window,
the group will show that all messages have been read within that group.
If the ‘Mark Last Read’ flag is not checked, then when you have read all the
messages that you are interested in, and return to the group list, optionally use
the ‘Mark Read’ menu item to mark all messages as read. Then only new messages
will show the next time round for that group.

Reading from last read message
With the ‘List new messages first’ option unchecked, messages will be listed from
the last read message, or the first message in the group if you are looking at a
group for the first time.
With a group that holds a great deal of messages, you may well find that the first
time you look at the group, it is best to mark all the messages as read. Then when
you next open that group, you will only see a more manageable amount of new
messages.
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If you have checked the ‘Mark Last Read’ box for that group list, then the last
message that you have read will automatically mark all those before it as read.
If the ‘Mark Last Read’ flag is not checked, then when you have read all the
messages that you are interested in, and return to the group list, optionally use
the 'Mark Read' menu item to mark all messages as read. Then only new
messages will show the next time round for that group.
Refer to the appropriate sections in the manual for further details.

Caution
SNAP will automatically create some subdirectory folders when it is first started.
It is important for the smooth operation of SNAP, that you do not alter or change
any of the contents of the 'Servers' folder. To do so might cause you to lose server
and group list information, and might also mean that you would need to start
over with the server and group lists.
To remove a server entry, or a group list, do so by using the options provided
within the 'Servers' or 'Build Group Lists dialogs'.
The contents of both 'SNAP.Data' folder, and the content of the folders in the
'Archives' folder, can be deleted or changed, but only while SNAP is not
running. Be careful what you change, as you may effectively hide files from
SNAP, or cause them not to display properly. If all you do is delete files from
these folders, all will be well.
Note: If you delete the 'SNAP.Prefs' file, you will need to to reset any preferences
you have changed. Refer to 'Setting Preferences' for more details.
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Advanced

Advanced Features
Editing Servers
Before you can start using SNAP, you will need to create at least one server entry.

To add or edit a server entry, select 'Edit Servers' from the 'File' Menu. This
opens a dialog, where you have three options:
New - To create a new Server record.
Delete - To remove an existing Server record.
Edit - To edit an existing Server record.
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Note: If you 'Delete' a Server record, it will remove all references, files, and
folders for that server. This includes any group lists you have created, and if it has
been built, the Full Group List as well.
Note: Both 'New', and 'Edit', open the same dialog window, though the Menu
Title cannot be changed if you are editing a server entry. The dialog consists of a
number of fields and a checkbox. Some of the fields are required, and others are
dependant on the requirements of the particular server:
Note: Menu Title, News Server, User Name, and User Password, are used to
configure the news server. Real Name is used for both posting to a news server,
and for emails. Reply To: is used for posting. Mail Server, Name, and Password, are
used for sending mail.

Menu Title: Enter a name to use locally for this server in the menus. This will be
used to name its related folder on disk. You can choose any descriptive name you
like. The name can be up to 15 characters long, must start with a letter, but may
not contain spaces. It should be descriptive, so you can easily identify it from the
popup menu. This field is required.
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News Server: Enter the IP address of the news server. This must point to a valid
news server, eg. news.giganews.com. When you click the 'OK' button, a quick
check will be made to see that the address is valid. This field is required.
User Name: If your news server requires you to login, this should be the name
given to you to log into the account. If your news server does not require you to
log in, leave this field, and the User Password field, empty.
User Password: If you supplied a 'User Name', then enter the password for that
user name. The password is hidden as you type. If your news server does not
require you to log in, leave this field empty.
Real Name: Enter either your real name, or a nickname of your choice. It will be
used in the 'From:' field of any messages or emails that you post. This field is
required.
Reply To: Enter either a real mail address, or for security, a pseudo mail address.
It will be used in the 'Reply To:' field, and to build the 'From' field, of all
messages that you post. This field is required.
Tip: To avoid spam as a result of posting messages to news groups, it is common
to disguise the Reply To address in some way, eg. yourname@nospam.myisp.com.
Mail Server: If you wish to send Mail from SNAP, you must enter the IP address
of a valid SMTP mail server. When you click the 'OK' button, a quick check will
be made to see that the address is valid. You must also provide an email address
in the box to its right, which will be used in the From field of emails. Your SMTP
server will probably require that this is a valid email address that is allocated to
the Name and Password you use to log in with.
Name: If the mail server requires you to login, enter the name used to log into
the account. If the mail server does not require you to log in, leave this field, and
the Password field, empty.
Password: If you supplied a 'Name', enter the password for that name. The
password is hidden as you type. If the mail server does not require you to log in,
leave this field empty.
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'XPAT': If your news server supports 'XPAT' searching, you should check this
box. If your news server does not support 'XPAT' searches, and you make a
search with this box checked, an error message will be generated.

Signatures: You can provide a 'signature' for appending to your messages and
emails for use with each server entry. When composing messages or emails, if the
appropriate signature file is present, the 'Sign' button will be active, and you can
append that signature to the body text. Click the 'Signatures' button to enter up
to six lines of text for each signature.
Tip: Although you can enter a line wider than the window width, it is suggested
that for clarity you keep your signatures within the window width.
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Managing Lists
Group lists hold a list of group names. Once you have defined a server, you must
create one or more group lists for each server.

Build Group Lists: To create a new group list, click the New button, and enter a
name to use locally to name this group list in the menus, and to name its related
file on disk. You can choose any descriptive name you like. The name can be up to
15 characters long, must start with a letter, but may not contain spaces. It should
be descriptive so you can easily identify it from the popup menu.
Click the Delete button, to delete a highlighted Group List entry. This will delete
the Group List, and all the groups within it.
Edit Group List: Select a group from the popup menu to open an edit window.
You will see a blank window for a new list, or a list of the group names you have
already defined. You have three buttons, one edit box, and five menu choices:
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Add Entry: Click the button to open a dialog to enter a group name to add to the
list. The group must be a valid group for the current server. The names must be
entered correctly, or an error will be generated when SNAP tries to read message
counts. It is safer to copy and add names from the full group list, so you will
know that the name has been entered correctly. If you have copied a group name
from the Full Group List, paste it into this box.

Delete Entry: Click the button to delete a selected entry from the list. Note that
this is immediate, and cannot be reversed.
Mark Last Read: If you check this box, then the group count showing unread
messages, will be updated to the last message you have read from this group. If
you leave this box unchecked, you will have to manually mark messages as read
from the open 'Group List' window.
Article Limit: Enter the number of message headers you would like to read on
each pass. The larger the number, the longer it will take to get the message
headers. For groups that do not get many new messages each day, a value of
around 50 is suggested. You can always adjust this value later, if you find that
retrieving the message headers takes too long.
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Mark Read: If you have already been online with this list, there will be a count
showing to the left of group entries. This menu selection will mark all the
messages in a selected group as having been read, and the count will be reset.
Mark Pending: If you have already been online with this list, there will be a
count showing to the left of group entries. This menu selection will mark all the
messages in a selected group as being pending, or having not been read, and the
count will be set to the number of messages in that group. Note that there may
actually be less messages than the count reports, if some messages have been
deleted from within the range.

Show Full Group List: Opens the full group list for the active server, so you can
search for and copy group names. You must have first selected 'Rebuild Full
Group List' for this menu item be enabled. See 'Full Newsgroup List' for more
details.
Close: Closes the window and saves the settings to disk.
Quit: Asks for confirmation, and then Quits SNAP.
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Full Newsgroup List
To get a list of the news groups that a news server holds, you must first retrieve its
full list with the 'Rebuild Full Newsgroup List' menu command. For a news
server that holds a large number of groups, this can take some time, though it will
also depend on the speed of your connection, and the speed of your IIgs. If you
are using an Ethernet connection from the IIgs, it may take as little as six or
seven minutes to retrieve a list of over 100,000 groups. With a dialup modem
connection, it may take up to half an hour for the same number of groups!

It is not necessary to build a Full Group List if you know the names of the groups
you would like to add to a specific Group List. If you do not know the group
names, or would like to search for other groups, you must first build a Full Group
List for the active server.
The 'Show Full Newsgroup List' window, displays the full group list for the
current server. As some servers may hold a very large number of groups, which
can result in a large Full Newsgroup List file, group names are displayed as a
number of pages, each about 128K in size.
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Within a page, use the keyboard and scrollbar to navigate through the names.
When you select a name, it will be automatically highlighted ready for copying.
If there is only one page, navigation controls are not displayed. If there is more
than one page, navigate through the various pages using the playback controls at
the bottom of the window. These controls let you jump to the beginning or end of
the entire list, and to jump back and forth between the pages.
|<< - Move to the first page of the list
<< - Move to the previous page
>> - Move to the next page
>>| - Move to the last page
To find a group, click the 'Find' button, or select 'Find' from the Edit menu.
Enter the string, or partial string for a name, and make a search from the current
cursor position. To search for the same string again, just press OA-G, or click the
'Next' button. Highlighted names are copied automatically to the clipboard when
you close the window.
Tip: Clicking the 'Update' button in the 'Group List' display, will add to the end
of the list any new groups that have been added to the news server since a search
was last made.
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Rebuild Full Newsgroup List
As new groups can be added from time to time to a news server, you may want to
do a full rebuild of the 'Full Newsgroup List' once in a while. This will make sure
that any groups no longer on the server will be automatically removed, and that
any new groups are correctly included. If the number of groups on the news
server is small, you may also wish to 'sort' the list for easier access.

Click the Rebuild button to delete the old list and build a new one. This will
remove any groups which are no longer being held on the server. This can take
some time, depending on the number of groups the server holds, and the speed
of your IIgs.
Most servers will provide you at first with a more or less sorted list of groups, but
as time goes on, any new groups will get added to the end of the list. To sort the
list, click the Sort button. This might take an extremely long time, depending on
how many groups are in the list. You can stop the sort at any time, though once
you have clicked the button, it may take some time to clean up and end the
sorting process. With an emulated IIgs running at 127 Mhz, I gave up sorting the
111 thousand groups on the Giganews server after 24 hours had elapsed, as it had
barely made any headway on getting them in order! With a smaller list of groups
on another server, I was able to get further into the process in that time. I have
included the sort feature for those that would like to have the groups in order,
and who perhaps access a server with only a small list of groups, or just have
plenty of time in their hands.
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Reading Messages

When you double-click or Open an entry in a Message Header List, that message
will be displayed. The message header is not displayed in full, but at the top of
the message window, you will see some information extracted from the header:
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Subject - The Subject line from the message. This field may be truncated if it is
too long to fit in the available space.
Groups - The group or groups that the message was posted to. This field may be
truncated if it is too long to fit.
From - Who posted the message. Note this usually just shows the pseudonym.
This field may be truncated if it is too long to fit.
Date - When the message was posted.
Lines - The number of text lines in the message.
Scroll through large messages, and then optionally select text for replies.
From the 'Messages' menu, you have various options:
New Mail Message - Opens a window to send an email message. See 'Sending
Mail' for more information.
Reply By Mail - Opens a window to send an email with selected text quoted.
Information from the 'From' field, and the 'Subject' line, will be used to prompt
the edit boxes. See 'Sending Mail' for more information.
Forward - Opens a window to forward a news message as an email. The 'Subject'
line from the message will be used to prompt the edit box. See 'Sending Mail' for
more information.
New Posting - Opens a window to post a new message. This option will start a
new thread in the target group. You will be prompted with the current group. See
'Posting News' for more information.
Followup - Opens a window to reply to the current message. This option will
mark the message as being part of the current thread in the target group. You will
be prompted with the subject, the current group, and other fields that were
present in the original message. See 'Posting News' for more information.
Previous Message - Moves to the previous message in the Message Header List.
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Note that it only moves within that list, so you may need to close the message
window, the message header list window, and then reset the group count using
the 'Pending' command, if you wish to read earlier messages.
Next Message - Moves to the next message in the Message Header List. Note that
it only moves within that list, so you may need to close the message window, and
click the 'More' button, to read further message headers in the current group.
From the 'Edit' menu, you have these options:
Find - Opens a Find Text dialog, which lets you search for text within the
message, with an optional case sensitive checkbox. If found, OA-G will find the
next occurrence of the search string.
Save - 'Auto-saves' the current message to the 'Archives:Saved' folder. See
'Managing Lists' and 'Saving Text' for more details.
Save As - Opens a file dialog, where you can choose where to save the current
message. See 'Saving Text' for more details.
Page Setup & Print - Opens the print dialogs, where you can print the current
message. See 'Printing' for more details.

Note: When saving, printing, replying, or forwarding a message, if you have
selected any text, only that text will be used for the subsequent action. If you did
not select any text, then the entire message will be selected.
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Searching
There are two methods to search for messages on a news group, a quick and a
slower way. Not all news servers support the quicker 'XPAT' method of
searching, but if they do, check the 'XPAT' box in the server settings to activate
it. Note that Giganews does not support 'XPAT'.

The 'XPAT' method of searching is very much faster than normal searching, as
the search is actually made at the server end, and any matches will be returned as
a list of message numbers. SNAP takes these message numbers, and builds and
displays a message header list from them.
For all the servers that do not support 'XPAT', you will need to use the slower
method. This will read all the message headers sequentially from a group, looking
for a match in the target field. This can take a very long time if you search the
entire message range of a large group!
From the group list display, select a group to search, and open the search dialog
from the 'Search' item in the 'Edit' menu. Enter a target string, or partial string,
in the text box, and select the range you wish to search from in the boxes. The
'start' and 'end' message numbers are prompted, so simply narrow the range as
required, upwards and downwards from the displayed values. Click either the
'From' or 'Subject' radio buttons, and then click the 'Search' button to start the
search.
Any messages that are found that match the target text, will be shown in a
message header list. If none were found, an alert will be displayed.
Note: If you use the 'XPAT' method, and the server does not support the 'XPAT'
command, an error will be generated.
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Posting News
Messages can be posted to a group or groups, and can either be posted as a 'New
Posting', which will start a new thread, or as a 'Follow Up' to an existing message
thread. The 'Group', 'Subject', and body text fields are all required.
If you are posting a new message, then only the 'Groups' field will be prompted.
You must set the 'Subject' field and body text, but can also edit any of the other
fields as necessary. If it was present in the original message header, the 'Keyword'
field may also be prompted. If you edit the 'Keyword' field, you can use multiple
words spaced with commas. Be careful if you edit any of the fields, to make sure
that you leave them as valid fields.
If you do not enter an address in the ‘Reply To‘ field, then the default address will
be used. If you enter a ‘Real Name‘ in this format, ‘Me <mail@where.com>’, then
the default Real Name will not be used.
If you are 'Following Up' a message, then either selected text from the original
message, or the entire text, if none was selected, will be quoted as your reply. You
must either edit this text, or add to it, or SNAP will not let you post the message
until you do.
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The fields are as follows:
Groups - This is either a single group, or a list of groups separated by commas. If
you are 'Following Up' a message, this will show the groups that the original
message was posted to. The message will then be posted, or cross-posted, to the
groups listed in this field. This field is required.
Reply To - This is seen as the 'From' field in news clients, and is either a real
email address, or a pseudo email address. For security, and to avoid spam, it is
common to use a variation of your real email address such as 'My Nickname
<myname@nospam.myisp.com>'.
Keyword - An optional list of keywords, separated by commas, that can be used
by search engines to find this message.
Followup - By entering a single group, or a list of groups, to this field, they will
be used instead of the current group if replies are posted to the message. This
allows you to redirect any replies.
Tip - A special case is if 'Poster' is entered (without the quotes) instead of a group
name. In this case, replies to the message can only be made as emails to the email
address in the 'Reply To' field.
Subject - This can be any descriptive text that you like. It will be used by news
clients to display in the Subject line, and by search engines to find this message.
If you are 'Following Up' a message, the original 'Subject' text will be shown with
a 'Re: ' prefix. This field is required.
Body Text - This can be a quoted reply, or any text that you supply yourself, or a
text file that you have inserted. This field is required.
Menu options:
Save As - Opens a file dialog, where you can save the message before posting.
You will be prompted with the 'Archives:Saved' folder, though can save it
anywhere on disk that you like. If you save into the 'Archives:Saved' folder, you
can later use the Archives feature to open it up again. Use this feature to save a
partial message for later editing and posting.

37

Insert Text File - This allows you to insert text from a text file directly into the
body text. Note only the data fork of a Teach file will be inserted, losing any
formatting. You can also insert the text from an HTML file, though may need to
edit out any formatting that gets left behind.
Page Setup & Print - Opens the print dialogs, where you can print the current
message. See 'Printing' for more details.
Find/Replace - Opens a Find/Replace Text dialog, which lets you search for and
replace text within the message, with an optional case sensitive checkbox. If
found, OA-G will find the next occurrence of the search string.
Spell Check - If you have NiftySpell™ installed, will spell check any selection, or
the entire text.
Show Clipboard - Displays the current Clipboard.
Show Full Group List: Opens the full group list for the active server, so you can
search for and copy group names to paste into the 'Groups' field.
Note: The 'From' field of any messages you post will be built using both the
'Real Name' you defined for the current Server, and the 'Reply To' fields, in this
way:
From: Your Real Name <replyto@your.isp.com>
If you have defined a Forum signature, clicking the 'Sign' button, will append
that signature to the end of the message. You can then edit the signature if you
wish.
If you do not fill in a required field, or do not fill it in correctly, or the message
cannot be sent for some reason, an error will be generated. You will get a chance
to then correct the error.
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Sending Mail
For your convenience, a simple mail client has been included. This allows you to
post mail either as a new mail message, a reply to a group message, or to forward
the contents of a group message to an email address. You must have entered valid
addresses and account information in the Server entry for an SMTP mail host for
these menu items to be active. Refer to 'Editing Servers' for more details.

If you are posting as a new email, then only the 'Reply To' field will be prompted.
You must then supply the 'To' and 'Subject' fields and body text, but can edit any
of the other fields as necessary. Be careful when you edit any of these fields, and
make sure that you leave them as valid fields.
The 'To' field, and the 'Subject' field will be prompted. If you are 'Forwarding',
then only the 'Subject' field will be prompted. If you do not fill in the ‘Reply To‘
field, then the default address will be used.
If you are 'Replying By Mail' or 'Forwarding', then either the entire text, if none
has been selected, or selected text from the original message, will be quoted as
your reply. You must either edit this text, or add to it, as SNAP will not let you
post the email until you do.
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The fields are as follows:
To - This must be a valid email address, or comma separated addresses, for the
recipients of the message. This field is required.
Reply To - This will be seen as the 'From' field in the message, and should be a
real email address. If you do not use a real email address, then client spam filters
may well reject the message.
Cc - Optionally provide a further valid email address, or comma separated
addresses, for recipients of the message. These will appear in the 'Cc' field of the
message.
Bcc - Optionally provide a further valid email address, or comma separated
addresses, for recipients of the message. These addresses will be hidden, and not
appear in the message.
Subject - Enter any descriptive text that you like. This field is required.
Body Text - This can be a quoted reply, or any text you supply yourself. This field
is required.
Menu options:
There are menu options available to you while composing an email message. See
'Posting News' above for further details.
Note: The 'From' field of any emails you send will be built using the 'Real Name'
and 'Reply To' fields. Your SMTP server will expect this to be a valid address, and
may reject it if the 'Real Name' is not registered with them. It sent in this format:
From: <replyto@your.isp.com> (Your Real Name)
If you have defined an E-Mail signature, clicking the 'Sign' button will append
that signature to the end of the email.
If you do not fill in a required field, or do not fill it in correctly, or the message
cannot be sent for some reason, an error will be generated. You will then get a
chance to correct the error.
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Archives
If you have selected to keep messages you have either sent or posted, or have
'Saved' messages you have been reading, or have 'Saved As' messages into the
Archives/Saved folder, you can read these messages later from the Archives
popup in the Messages Menu. There are three options, 'Sent Mail', 'Group Posts',
and 'Saved Messages'. Selecting any of the three menu items, will show you a list
of any messages in their respective folders.

If you select a message from the Group Posts and Sent Mail lists, they will open
in the Editor, where you can read, and then edit them if you wish. See Editor for
further details.
You can delete a message from the list, which will not only remove it from the
list, but from disk as well.
If you select a message from the Saved Messages folder, it will open in either
'New Posting' or the 'New Mail' windows respectively. This allows you to continue
working on, and then to send, a message that you may have started, but have
'Saved' for later. Refer to 'Posting News', or 'Sending Mail', for further details.
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Editor
SNAP provides a general text editor that you can use either to view, edit, or
otherwise work on a message before posting or sending, or to view messages that
you have sent from the Archives folder. The Editor works in full TextEdit mode,
allowing you to change the font or styles. However if you then later post or send
the message, only the data or plain text fork will be sent, and the formatting will
be lost.

From the 'File' menu, you have these options:
Insert Text File - This will insert at the cursor point, plain Text files, Teach files, or
even process and insert an HTML file.
Babelfish™ - If you have installed Babelfish™, you can choose to import or
export text through any filters that have been installed. Please refer to the
BabelFish(tm) documentation for further details.
From the 'Edit' menu, you have these options:
Find/Replace - This opens a dialog where you can enter a search string, and an
optional string to replace it with. You can make the search case sensitive, and
choose to either 'Replace All', Replace', Replace & Find', or just find the 'Next'
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occurrence of the search string. If you choose 'Next', once found, the dialog will
close, and you can then find any further occurrences by pressing OA-G.
Spell Check - If you have installed NiftySpell™, this will spell check either the
entire test, or selected text. Please refer to the NiftySpell™ documentation for
further details.
Choose Font - Opens the standard Font dialog, allowing you to change the Font
or Style, of any selected text. Note: Although you can 'Save As' these changes as a
Teach file, if you then choose to 'Insert Text File' later into a new post or new
mail message, the formatting will be lost.
You can also use these menu options:
Save - 'Auto-saves' the current message to the 'Archives:Saved' folder. See
'Managing Lists' and 'Saving Text' for more details.
Save As - Opens a file dialog, where you can choose where to save the current
message. See 'Saving Text' for more details.
Page Setup & Print - Opens the print dialogs, where you can print the current
message. See 'Printing' for more details.
Show Clipboard - Displays the current Clipboard.
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Saving Text
From most message and other displays, you can choose to 'Save' or 'Save As'
either the entire text, or selected text, to disk. If no text is selected, the entire text
will be saved, but if you select a text range, then only that text will be saved.
If you are saving from a message display, a header will be added at the start.
A group message will have these six fields before the body text:
Subject:
Groups:
Keywords:
Followup:
From:
MessageID:
Reference:
An email message will have these five fields before the body text:
Subject:
To:
Cc:
Bcc:
Reply To:
Log files will have a header appended showing the current month. This is the
same header that you see at the start of every log file.
Selecting 'Save', will auto save to the 'Archives:Saved' folder.
If you are saving from a message display, the 'auto save' unique file name will be
in the format 'MSG130307093526'. The appended number is built from the date
and time the message was saved.
If you select 'Save As', you will be prompted with a file dialog, initially pointing to
the 'Archives:Saved' folder.
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Printing
Before you can print, you must first select your printer from the Printer Control
Panel, and have set the printing defaults from the 'Page Setup' menu item.
From the 'Editor', a 'Log' file display, and from a message display, you can then
then print either the entire text, or selected text, to disk. If no text is selected, the
entire text will be printed, but if you select a text range, then only that text will be
printed.
If you are printing from a message display, or while composing a message or
email, a header will be added at the start. Refer to 'Saving Text' for more details.
When printing text from from a Log file, a header will be appended showing the
current month. This is the same header you see at the start of every log file.

45

Setting Preferences
There are some global settings that can be set from the 'Preferences' menu item.
These settings are remembered when SNAP Quits.

Server Timeout - This is the number of seconds that SNAP will wait for a
response when calling up a server. Unless you think two minutes is too long, I
would suggest not changing this parameter. You can however make it larger or
smaller if you wish, but it must be within the range 30-600 seconds.
Quoted message string - When you 'Reply By Mail', or 'Follow Up', a message,
either the entire text, or the selected text of the original message will be quoted
in the reply. Each quoted line will start with the string that you enter here. You
can enter up to 20 characters, and it is suggested you always use a space for the
last character, so it separates the quote string from the actual text.
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Quoted message line length - When SNAP quotes message text, it will break
text down into the line length you set here. You can set the line length between
20 and 999 characters. Be careful though, and think what might happen with a
long quote string, and a short line length!
Group message line length - The maximum length of line allowed by news
servers is 1500 characters. That length includes the trailing CR/LF pair. SNAP
will split any lines that are longer than the value you enter here when it sends the
message. You can set the line length between 40 and 1496 characters.
List new messages first - If checked, will read messages from the newest
message back to the Last Read message. If unchecked, messages will be read
forwards from the Last read message to the newest.
Keep copy of sent messages - The default is for SNAP to keep a copy of any
messages that you post in the 'Archives:Sent.Messages' folder. If you do not wish
to keep a copy of these messages, then uncheck this box. The messages will be
saved with a name in the format 'SMG130307093526', where the numeric part of
the name is the date and time the message was saved.
Keep copy of sent mail - The default is for SNAP to keep a copy of any email
that you send in the 'Archives:Sent.Mail' folder. If you do not wish to keep a copy
of emails you send, then uncheck this box. The email message will be saved with
a name in the format 'SMM130307093526', where the numeric part of the name is
the date and time the message was saved.
Case Sensitive Searches - When SNAP boots, this is the setting that will be
used initially for the 'Case Sensitive' checkbox in the Find/Replace dialogs.
Ignore Updates
Check this box to disable the self-check for updates at Startup. The box will be
checked if you have clicked Ignore in an Alert showing an update is available.
Note: The headers of any messages or emails you send will always be saved to the
current 'SNAP.Log' file, regardless of the settings made here.
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Log File
The Log File keeps a record of the headers of any email or group messages that
you have posted. It also reports some of the failures that may occur.

Each month, any existing log file will be renamed to show the month and year it
was created, and a new file will be opened. You may want to periodically clean the
SNAP.Data folder of any old log files you no longer require.
If necessary, a new log file will always be created when SNAP starts.
When you view the log file, it will always scroll to the bottom, so you will see the
most recent events displayed. Only the last 256K of a large log file will be
displayed. You can choose to clear the contents if you wish. This will also clear
the contents of the file on disk.
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Extras

Requirements
You need a IIgs with at least 1Mb of memory, System 6.0.1, Marinetti 3.0b7 or
later, and a hard disk, or Compact Flash card pseudo disk. You must also install
the supplied 'Time Zone Tool', 'HTML Tool', and its associated fonts.
Ideally, you should have at least 2Mb of memory, and an accelerator card. You will
find that a direct connection to the Internet, such as is available from an Ethernet
card connected to a broadband router, will speed up the operation of SNAP
dramatically. If you are using Marinetti with dialup from a modem, then the faster
the modem, the more responsive SNAP will be.
Refer to the 'Quick.Start' file for details on installing SNAP, and refer to the
'Links' item, for details of how to get Marinetti, an Ethernet card, or a CF card.
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Help
If you have installed the optional !Help! files, you will find this entire manual is
available to you while you are within SNAP. Select SNAP from the !Help! item in
the Apple menu, and scroll down to the relevant section.
To install the !Help! files, if you do not already have it installed, you must first
copy the 'Help' NDA from the 'Help' folder in the SNAP.archive to the */System/
Desk.Accs folder on your boot disk. Now copy the entire the 'Help.Files' folder
from the SNAP.archive to the */System/Desk.Accs folder on your boot disk. You
will need to reboot your IIgs for the !Help! NDA to be activated.
If you already have !Help! installed, simply copy the 'SNAP' folder from the
'Help.Files' folder in the SNAP.archive, to the existing 'Help.Files' folder in the */
System/Desk.Accs folder on your boot disk.

Problems
Errors generated during the operation of SNAP, will usually display in an Alert
window. Take the necessary action to resolve or avoid the problem happening
again.
Some errors will be listed as they occur in the 'SNAP.Log' file.
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Appendix

Glossary
TCP/IP
Transmission Control Protocol/Internet Protocol, describes a method of
transmitting packets of data over a network. Each packet contains addressing and
sequence information. This allows the route the data takes to be flexible.
http://en.wikipedia.org/wiki/Internet_Protocol_Suite

Link Layer
Part of the TCP/IP protocol, which handles the interface with the Internet Layer
and the Network. Marinetti supports a range of Link Layers from Direct Connect,
through SLIP to Ethernet.

SMTP
Simple Mail Transfer Protocol, describes the method of sending mail to a server.
http://en.wikipedia.org/wiki/Simple_Mail_Transfer_Protocol

ISP
Your Internet Service Provider provides you with your connection to the
Internet, either through a DSL broadband, cable, or dialup modem connection.
http://en.wikipedia.org/wiki/Maximum_transmission_unit

NNTP
New Network Transmission protocol, used to connect to NNTP news servers such
as those covering Usenet.

User Name & Password
Used to login into your NNTP or SMTP mail accounts.

Case Sensitive
Text can be in UPPER CASE or lower case. Searches made with SNAP can be set
to ignore the case of the text during a search, or can be made to respect it.
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To order a CF card:
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